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DSPA is a 3D digital simulation and preview system specially designed for 
and tailored to theatres. For enhancing the theatres' executive efficiency 
and performance quality, and celebrating the opening of the new building 
of the Taiwan Traditional Theatre Center, the center has engaged in the 
development and design of the 3D digital simulation and preview system 
since 2014. This system is based on cross-sector collaboration and 
technical applications and serves to facilitate theatre management and 
performance production. It comprehensively integrates hardware equipment 
such as lighting, audio, multimedia devices and technical components in 
a theatre, and allows the creation of equipment and technical modules to 
be realized through a single control interface, so as to free theatre writers, 
directors, designers and performers from geographic and time restrictions 
and endow them with the abilities to simulate operations and preview visual 
presentation before stage performances, thereby reducing stage setting 
time and improving working efficiency through timely communication and 
decision-making, and eventually ensuring the integrity and refinement of 
the performances.
 

Welcome to DSPA1
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Cross-Discipline Integrated Interface

Cross-discipline integrated interfaceThe system integrates functions like the "six main disciplines," cue-list 
setting and the Director Mode, and is the first platform enabling the overall planning of works belonging 
different disciplines, with interface specially designed on the basis of cue creating experience for theatre 
designers' easy adoption. This system provides intuitive interface and abundant cross-platform functions. 
Many leading 3D animation applications, e.g. Autodesk Maya, Adobe Photoshop Element, etc., and leading 
businesses like DreamWorks and Walt Disney Animation Studios are using Qt as the graph interface 
framework of their software products.

Newly Developed Real-Time 3D Graph Engine (Lizard) Combined 
with VR System

Designed for real-time simulative rendering effects of multiple light sources, the next-generation 3D 
rendering engine supports the programming language (Shader) of the state-of-the-art hardware graphics 
processing units (GPUs) and cross-platform application frameworks (DirectX11, and OpenGL4), so it can 
generate simulative images through high-efficiency hardware acceleration in a real-time manner, and 
when combined with the mainstream VR framework (Steam), can enable development of VR systems. 
Allowing a designer to review scenes designed using this system through VR equipment is a significant and 

challenging task when we developed this system.
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High-Performance Multi-Light-Source Rendering Computation

Another issue for this project to address is that a theatre is usually equipped with a huge number of stage 
lighting devices, which have various features. The traditional hardware acceleration flow can manage 
at most 8 hardware lights in terms of rendering, and is thus incompetent for this project. Therefore, 
we introduced the advanced technology named Deferred Rendering, which uses mathematical logic to 
convert all calculated light-and-shadow effects into screen coordinates (Screen Space) for subsequent 
processing. Ideally, it accommodates calculation of infinite lights for a single scene. With this technology, 
the quantitative restriction about light sources can be substantively eliminated.

Adoption of Light Scattering

Smog can be used in stage scenes to form particular atmosphere and effects. Without considering 
refraction and scattering of light caused by objects appearing on the virtual stage, the calculated 
rendering effects can be less real. Hence, we introduced the technology called Light Scattering that 
reflects light consumption profiles of different substances in the calculation of light-and-shadow effects. 
This technology ensures that the light-and-shadow effects presented by the system answer to natural 
energy distribution and consumption, and lighting effects produced by projection lights such as God Ray 
can be accurate and real.
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Future Prospects

We hope this practice-based system will be available to more "theaterers" in the future, and we plan to 
provide learning resources (e.g. a tutorial video) through the internet, making this system show its value in 

real theatre works.
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Software Installation2
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(I) Recommended Hardware Specifications

The minimum specifications for this system are:

(II) DSPA Install

1.Installation

Step 1. Load the disk of 3D Digital Simulation & Preview System (DSPA), and the file setup.exeinstall will 

be executed automatically. The following drawings are scenes appearing during application installation.

Step 2.When seeing the pop-up dialog, click on [install] on the left.

Item Description

Operating system Windows10 64bit or above

Graph processing unit

(GPU)
NVIDIA GTX1070 or above is recommended

Central processing unit

(CPU)
Intel i7-6700 or above is recommended

Random Access

Memory (RAM)
16G or above is recommended

Hard drive (HD） 512G or above is recommended

Stage Lighting Controller ETC ION

Stage Lighting Operating 

system
ETC ION: 2.9.0

→ 
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→ 

Step 3. Follow the instructions and then click on "Next" to install.

Step 4. Click on "Create desktop shortcut",then click on "Next".

Step 5. Click on "Install AppData" and "Finish".
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→ 

Step 6.It will show the installation process.

Step 7. The program can be found on the desktop.

Step 8. It will need an account name and serial number to start for the first time. 
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Step 9. Click ''confirm''.

Step 10. Enjoy the program.

2.Note
When problems occur during installation, please follow the instructions below:
(1) Q: A pop-up window warns me of failure to open the file.
    A: Please check whether a plug-in of "Direct11 or above " has been installed.
(2) Q: When I tried to install a plugin of a newer version, the installation failed.
    A: Please remove the old DSPA, and reinstall the application as a whole.
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(III) VR Mode

Since the VR mode of this system is designed to be used in conjunction with SteamVR, please visit 
Steam's official site and apply for membership. After log in Steam VR, you can use HTC VIVE to view the 
scenes. Before conducting the below operations, please first set up your VR equipment as instructed by 
the manufacturer and check the functionality of your VR equipment:

1. Creating An Account In STEAM Shop
Visit Steam's official site https://store.steampowered.com/ and log in. If you don't have an account, please 

create one first.

2. Installing HTC VIVE
Step 1.  Select the mode of room setting. The application can work with either of the modes, which are 
different in following aspects:
1) Room-scale: The user can walk around in a predefined space, but for a long-range movement, a VR 
controller as to be used for position selection (teleport).
2) Standing: The user can only view from a fixed position, and no movements are possible without a VR 
controller.

→ 
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Step 2.  After the headset is set, please click on "Next."

Step 3.  After space calibration for the headset is done, please click on "Next."

Step 4.  After the ground is positioned, please click on "Next."

→ 
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Step 5.  After the above settings are made, please click on "Next."

Step 2.  After the VR mode is selected, please wear the headset to view the contents of the DSPA 

system, and use "controller operation" to move in the space (or walk around in the predefined space if the 

initial settings have been made for the room-scale mode). 

After completing the above operation, you can view your design through the VR equipment (referring to 
"VII. VR Mode"), and can use the "Export" function to export the design as a 360 VR video (referring to 

Export Charts, VR in "IV. Basic Operation) to be played through mobile devices.

3. How To Use VR System
Step 1.  Start the application, and select "View/VR mode" from the main menu.



User Interface3
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This system provides six subsystems, namely "Stage, Lighting, Audio, Video, 
Effect, Character" and Director mode, and incorporates VR functions to 
provides the VR mode. Functions operable through the main interface are 
"Main Menu, Quick Launch, Data Management Area, Attribute Editing Area, 
Scene Editing/Viewing Area, and Cue List Editing Area," which will be further 
described in later sections. 



v
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(I) Main Menu

Terms used herein are listed below:

(1)Main Menu

(2)Quick Launch

(3)Data Management Area

(4)Attribute Editing Area

(5)Cue List Editing Area

(6)Scene Editing/Viewing Area

 Remarks: Basic operations with

 mouse/keyboard

• Select object: direct clicking with mouse

•  Pan scene: Alt+ Middle mouse button
•  Shift perspective: Alt+ Left mouse button

•  Zoom scene: Alt+ Right or Middle mouse button

English  中文 Hot key

File 檔案

New Project 新専案

Open Project 開啟舊專案

New Template 開啟預設劇場

Scene Load 讀取場景

Scene Import 

Stage Import 

Stage Set/ Video/ Effect 

Lighting

Audio 

Character 

匯入模組

舞台懸吊模組

舞台佈景 / 影像 / 特效模組

燈光模組

音效模組

角色模組

(1)
(2)

(3)
(4)

(5)

(6)
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English  中文 Hot key

Scene Save 儲存場景 Ctrl+s

Scene Save As... 另存場景

Import 

Stage file 
Audio file 
Video file  
Character file 

匯入

舞台模型
音效檔案
影片檔案
角色模型

Export

Model 
Capture Image 
Capture Video 

匯出

模型
擷取畫面
擷取影片

Exit 結束

Edit 編輯

Undo 回復 Ctrl+Z

Redo 重做 Ctrl+Y

Reset Lamp' s Intensity 重設燈光強度

Cut 剪下

Copy 複製 Ctrl+C

Paste 貼上

Delete 刪除

Mode 子系統

Director 導演

Stage 舞台

Lighting

Ambient Light
Select Light
All Light
Show Cone
On/Off

燈光 Ctrl+L
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English  中文 Hot key

Audio 音響

Video 影像

Effect 特效

Character 角色

Audio File List 音樂清單

Video File List 影像清單

Play 播放

Back 回上一 Cue

Go 播放

Pause 暫停

Stop 停止

Forward 跳至下一 Cue

Windows 視窗

Layout

One Viewport
Left/Right Viewport
Up/Down Viewport
Four Viewport

視窗佈局

單一視窗
左右分割
上下分割
四分視窗

Library & Layer 資料庫及圖層

Attribute 屬性視窗

Cue List Cue 表

Show All 全部顯示 F11

Hide All 全部隱藏 F10

Language 語言

English 英文



(II) Quick Launch

The tool bar of DSPA includes hot keys for Mode, Audio/Video Library, Undo/Redo, Layout, Playback, 

Object Control, Export Control, System Setting. Further description for each function will be given below.

1. Mode:

There are six modules for you to select from, namely "Stage, Lighting, Audio, Video, Effect, and Character, 
" and a work is only editable in the window corresponding to the module it belongs. The detailed 
operations of the modules will be described in Chapter II through Chapter VII.

2. Audio/Video Library:

Press one of the key to access the audio or video library. For adding audio/video files to the corresponding 
library, please click on "+" at the lower left corner of the scene.

3. Undo/Redo:

By pressing Undo reverse your last action, and by pressing Redo reverse your last Undo.

4. Change The Camera's Perspective:

Change the camera's perspective by your need.

5. Layout:

There are four layouts for you to select from, namely "One Viewport, Left/Right Viewport, Up/Down 

Viewport, Four Viewport."
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English  中文 Hot key

Chinese 中文

Help 幫助

About 關於

Export 匯出

Export Report 匯出報表



6.  The Stage Lighting Controller:

By connecting with a stage lighting controller, the controller can operate the program directly. 

7.  Playback :

The hot keys from the left to the right are: move to the previous cue (Back), playback
(Go), Pause, Stop, move to the next cue (Forward).

8.  Object control:

Click on the keys to activate one of the desired object-controlling functions, including select the object, 

move the object, rotate the object, and zoom the object.

9.  Export :

Capture the current scene to export as an image or a video.

10.  System Setting：

In Environment you can set the default for ambient lighting. The fields Stage/Apron/Auditorium correspond 
to Stage Lamp/House Light 1/House Light 2. In the lower Lighting Cue part, you can set the light list to 
be exported later as Cue Only or Tracking. Also there are three different render quality can be chosen 

depend on the hardware specifications.

21



(III) Library Management

You can use this area to manage information of the following records, including: (1) Library, (2) Layer, (3) 
Focus, and (4) Cue. The items in each group are easy to set and adjust, thereby facilitating the production.

1. Library:
You can view equipment lists of different modules here, and add items to the list by pressing "+".

2.  Layer：
To manage equipment in different modules, you can choose to view or lock an object by checking the 
corresponding box.

22



3.  Focus:
The interface in the lighting system is used to set light focuses. New focuses can be added by pressing 
"+"  , and by pressing " Ⓞ " you can set focuses in the scene fast.

4.  Q-Group:
The interface under Director Mode is used to set colors of cues for easy differentiation between 

segments.

23



(IV) Attribute Editing Area

Attribute data are information about the selected object, and include settings of the

object's attributes as well as basic information.

(V) Cue List Editing Area

This area is where cue lists of different modes are edited. The interface is composed of two parts, namely 
Mode Switch and Cue List. There are seven modes to select, wherein Stage Mode includes settings for 

rigging and properties. You can find integration of cues of all modes in "Director Mode."

1. Mode Switch Area：
You can switch among control pages of eight modes here.

2. Cue List Area：
You can see cue lists here either in a table with basic information or in a Director Cue List view.

→ Attribute Editing Interface (lighting attributes shown for illustration)

→ Cue List 

→ Director Cue List Interface

24



Iso View Top View

Front View Top View

Button View Back View

Right View Free View

(VI) Scene Editing/Viewing Area

In Scene Editing/Viewing Area, different views can be selected from a list called up by right clicking the 
mouse for you to check position settings and object placement across all views.

→ Scene Editing/Viewing Area Interface

25

→ 



Remark: you can see one or more views by selecting one of the four viewports from.

26
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Basic Operation4
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(I) New Project

Step 1. Please click on "File >New Project" in the main menu. Then add and save the project name to the 

folder "DSPAproject" created under C://. There shall not be any folder named in Chinese in the path to 

the project.

Step 2. If this is the first time you open the application, you will be inquire about where to store the 

project. At this time, please select the project folder you just created, and enter the project name (.tproj) 
before pressing "Save." The project name shall not contain Chinese characters.
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Step 3. Check the project folder you just created, and if you see the view below, the project folder has 

been established successfully. After the above steps, you can begin to work on the project.

Step 4. If this is the first time you use this application, you have to set a venue by clicking on "File /New 

Template." In this application there are nine options of stage. Also wherein the custom scene allows you

to set "Stage Size and Proscenium Size."

→ 



The Main Theatre Experimental Theatre

3102 3201

Custom Scene Weiwuying Theater Hall

Yilan Concert Hall Chiang-Wei-shui Theater Hall

Zhong-Shan-Tang Performance Hall

This application is preloaded with the following venues:

30



31

Step 5. After the selected venue appear, you may click on "File/Save As," and name a new file in the 

project folder, so that the file will be loaded automatically when you open the application next time.

Step 6. For opening an existing scene, please click on "File/Scene Load" and select a scene file (.TAC) 

you've edited previously.
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(II) Open Project

Step 1. Please click on File >Open Project.

When the above step is completed, you can start to work on the scene.

(III) Import From Other Modes

Step 1. After the scene is opened, please click on "Import Mode" and select the mode form which you 

want the data to be exported, such as Lighting.

Step 2. You may repeat the above operation to import data from more modes.
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(IV) Scene Import

If you want to add a model you created earlier into the application, please click on "Import" and then "Add 
to Library." You may import files of stage models (for properties
on the stage), audio effect files, video files, character models, and Gobo files. The illustration below is 

about import a character model:

1. Import external models

Step.1 Please click on File >Import >Character File

Step.2 Select the file folder you want to import.

Step.3 After the above operation, you can check the model you just imported in Character Library. Now 

you can drag and place the imported model into the scene and then click on entries to see whether the 

attributes and function settings work as intended.

→ 
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2.  Create Internal Models

Step.1 To name or make basic setting for the model, please click on "+", below Library, select the model 

to be set in a view like below, check Customize Setting, and edit the creator's name and basic info.

Step.2 After clicking on Confirm, you can see the customized model in Library on the left.
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(V) Lighting Switch

Three types of lighting can be controlled here:

Ambient Light

Selected Light (Multiple lights can be selected)

All Light

Operations for Ambient Light are described in the illustration below for example:

Step.1 Click on Edit >Lighting >Ambient Light in the main menu to make Ambient Light marked with a 

check.

Step.2 Click on "On/Off" to turn it on or off (you may use hot keys "Ctrl+L" instead).

Now you can see the ambient lights are turned off.
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(VI) Export Chart , 360VR

1. Export Chart

Step 1. Select "Export Data"

Step 2. Select the items you need in the menu and click on Confirm. If you want

to see "Ruler," please enable Ruler (Ctrl+L) before exporting the data.

*The forms can be exported as Microsoft Excel files and PDF files.

Chart Type Exemplificative View

Light Focus Top View

Light Focus Side View
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Chart Type Exemplificative View

Theatre Front View

Theatre Plan

BOM Table

Cue List

Audio File List

Video List



2. Export 360VR

Step 1. Please click on "File/Export."

Remark: The exported video will be processed and uploaded to Youtube and you can use a handheld 

device (e.g. a smartphone, a tablet, etc.) to check the 360VR simulation result.

Link to the tutorial website for generating 360VR videos and its QR code:

https://support.google.com/youtube/answer/6178631?hl=zh-Hant

Link to the tutorial website for uploading videos to YouTube and its QR code:

https://support.google.com/youtube/answer/57407?CO=GENIE.Platform%3DDesktop&h|=zh-Hant

* In the event that YouTube changes its official settings, please search for "Settings for uploading 360 

videos to Youtube."

38



Introduction to Operation 
of Six Modes

5
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(I) Stage

1. Library
Step 1. Click on the icon of Stage

Step 2. Entries related to stage settings will be shown in the field of Library.

• Import objects
In DSPA, some properties need to be added manually to the library in addition to the curtains. Under 

Library, click on "+" at the lower left corner to open a window where you can select the objects you want 

and click on Confirm to add these objects to the library. You may also add 3D properties you have created 

(How to import external files and the naming policy will be further described in "Chapter 8").



2. Set Attributes
Under Stage, you may use Attributes to set adjustable attributes of stage objects. Attribute settings very 

depending on objects. The views below are for setting "Curtains"

and "Property," respectively.

3. Stage Setting and Editing
Stage Rigging

·Preloaded batten layouts

In this section we'll introduce the batten layouts of the Main Theatre, Experimental Theatre, 3102 and 

3201. The layouts of all the battens truly reflect the on-site placements for best possible simulation 

results.

41

↑ Attributes of Curtain ↑ Attributes of Property

→ 
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↓ The Main Theatre-Off-stage overhead rings.

Serial Nos.: SS#1 – SS#2/2 battens in total

↓ The Main Theatre-Main stage overhead battens

Serial Nos.: #1 – #72/72 battens in total

↓ The Main Theatre-Auditorium overhead battens

↓ Experimental Theatre -catwalk (the area framed by blue lines are where objects can be hung along the 

catwalk.)

↓ The Main Theatre-Orchestra pit overhead 

battens.

Serial Nos.: OS#1 – OS#6/6 battens in total

↓ The Main Theatre-Back stage overhead battens

Serial Nos.: RS#1 – RS#7/7 battens in total

↓ Experimental Theatre -Main stage overhead 

battens

Serial Nos.: #1 – #12/12 battens in total
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Step.1 View Selection

When hanging objects in Iso View you can see batten nos. more clearly and arrange curtains and 

properties around the stage easier than in other views (right clicking the mouse in the screen to select Iso 

View). Four kinds of curtains have been loaded, including Main Curtain, Border, Black Drop, Split Middle 

Curtain.

Step.2 Hang objects

To hang curtains, please drag curtains preloaded in the library to the positions on battens.

• Preloaded stage gears
This section is directed to stage gears in the Main Theatre, Experimental Theatre, All the gears are dawn 

in scale for the best possible stimulation results.

→ 
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• Orchestra pit in the Main Theatre (6 modes)

• The Main Theatre's trap room platform (182 pcs) can be seen as the original platform or the trap room 

platform according to the settings you made in the right field.

• The Main Theatre's three-layer turn-table (5m/9m/13m) can be dragged to the stage from the library.

• Experimental Theatre's trap room platform (54 pcs) can be seen as the original platform or the trap 

room platform according to the settings you made in the right field.
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• Scenery setting
How to place objects on the stage

Step.1 Add object

Click on the object you want to place in the library and drag it to the stage.

Step.2 Move object

You can set the position of the object on the stage in the attribute field on the right using X-Y-Z 

coordinate.

→ 
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4. Cue

• Cue list for rigging
Step.1 Add batten motions

Click on under "Motion" in "Attribute Setting" of "Batten +", set the altitude (using Coordinate Z), and set 

the history of edition as the default of motions. Instead of entering coordinates, you can add a motion of 

an object by using an arrow moved to the designation.

Since a movement is formed by point-to-point motions, at least two motions (e.g. Dn and Up) have to be 

set for later movement edition of the cue list.

Step 2. Set a cue list :

Select a batten to edit, and double click the batten's Stand-By field to set its initial position and to select 

the motion to set.

→ 
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In Cue 1, set the up/down positions (defined when you edited the attribute), and enter the time period you 

want the motion to last in Duration Time.

After setting the positions, move to the left to set Start Time and the total time length for Cue1.

After finishing the above settings, move to the left to select the field Cue, and click on Stop to zero all the 

attributes. Then click on playback to preview the motion of this cue.

• Cue list for scenery
The following sections will be directed to attribute setting for stage gears, curtain opening & closure and 

property shifting, and their use in cue lists.

• Stage gears
Step.1 Click on the stage, and in "Central Stage Type" in the attribute field select TRAPPLAT, which 

means the trap room platform.

→ 
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Now you can see the scene below:

Step.2 Click on anywhere in the trap room platform, and set altitude in "Motion" under "Attribute Setting" 

(using Coordinates Z). Instead of entering coordinates, you can add a motion of an object by using an 

arrow moved to the designation. It is to be noted that since a movement is formed by point-to-point 

motions, at least two motions have to be set for later movement edition of the cue list.

• Turn-Table
Step.1 From the library of Stage, drag "Turn-Table" to the stage.

→ 
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→ 

Now you can see the scene below:

Step.2 Click on "+"beside the motion list to add motions of the turn-table. Motions of the turn-table 

are designated using angles. Please enter rotation angles you need in "Inner Ring Motions," "Middle Ring 

Motions," "Outer Ring Motions" under Attributes. It is recommended that you set the default position of 

each ring (rotate for 0 degree) as a motion to avoid confusion, and use the setting in the field Stand-By 

of the cue list. The illustration below showing how to make this setting in "Inner Ring Motions."

• Curtain closure
Step.1 We take settings for the main curtain for example here. You can drag MainCurtain from the library 

under Stage to the batten.

After clicking on the object, please move to "Motion" under "Attributes" on the right and click on "+", to 

add motions for the main curtain.
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Curtain Open Distance is the width of the opening between the curtains, and the greater value leads to 

the larger opening.

Step.2 Then in the field MainCurtain in Cue List below edit the curtain's motion

in each cue and how long the motion lasts.

• Property shifting
Step.1 We take settings for a black table for example here. You can drag BlackTable from the library 

under Stage to the batten.

→ 
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Step.3 Then in the field BlackTable in Cue List below edit the curtain's motion in each cue and how long 

the motion lasts.

→ 

Step.2 After clicking on the object, please move to "Motion" under "Attributes" on the right and click 

on"+" to add motions for the property. Since the movement of properties may involve displacement and 

rotation, the values to set in Motion Editor are Position and Degree.
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(II) Lighting
This system has been preloaded with lights currently installed in the "Taiwan Traditional Theatre Center" 

and these lights are shared by the Main Theatre and Experimental Theatre. You arrange these lights and 

set their attributes under Lighting. To make setting and planning and to stimulate the lighting effects, 

please follow the path: Icon "Lighting,", "Lighting Library," "Focus," "Attributes " and "Lighting Cue List."

1. Lighting Library

Step 1. Click on Icon "Lighting" icon

Step 2. Use the contents of Library which have become the entries of the lighting module.

2. Arrangement Of Lights

Where you can arrange lights

This section will be directed to areas available in the Main Theatre, Experimental Theatre,for installation of 

lights. The batten areas open to lights are identical to those described in the previous chapter "Stage" (see 

p.45~50). In addition to batten areas, otherequipment may be used to support lights. The details of each 

venue are given below:

→ 
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• The Main Theatre
Batten areas: (see illustration in "Stage," Chapter I, p.45)

Off-stage: 2 battens (hanging rings)

Orchestra pit: 6 battens

Main stage: 72 battens

Back stage: 7 battens

• Stage ladder
Totally 6 towers are located at two sides of the main stage, three for each side.

• Experimental Theatre
Batten area:Twelve trusses are hung over the stage of Experimental Theatre for hanging lights.

• Extension of battens
There are extensions in the library of Experimental Theatre including Truss-3m / Truss-12m / Truss-

Corner for you to use and hang lights.

→ 
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• Properties (common to stages) 

• Movable lighting stands
This item is available in the library under Stage and named as Boomstand-Tower.

• Floor light bases
This item is available in the library under Stage and named as Shine Base.

• How to arrange lights

Step 1. Import lights from library

When hanging lights in Top View you can see batten nos. more clearly and arrange lights preloaded in 

the library of this stage to battens or lighting tower, or select battens or lighting towers easier than in 

other views. (Right click the mouse in the scene to select Top view). When a light is blue highlighted in the 

library, you can arrange this light in different sites successively. To deselect the light for further mounting, 

please click on the light in the library again to unhighlight it.

→ 
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Step 2. Mount lights on to lighting towers

You can do this in the same way as mounting lights on battens by dragging the light from the library to the 

targeted lighting tower.

Step 3. Change battens

You may use "Fly" under "Attributes" to move a light you have arranged to one batten to another batten. 

For moving multiple lights, please hold Ctrl while selecting multiple lights and move them together.

Step 4. Review lighting effects

Now you can change to "Free View" to check the resulting lighting effects and then make adjustment and 

fine-tuning as required.
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3. Set Attributes

In view of the complexity of light setting, a dedicated section is provided here for itemized description. 

After lights are mounted on battens or towers, configuration and setting have to be made according to 

their specifications:

• Lighting attribute interface

The items in "Attributes" under "Lighting" will be explained below. Some settings can be seen in the light 

plan UI in Top View.

(1) 頻道 / Channel
(2) 調光器 / Dimmer
(3) 色溫 / Color Temperature
(4) 顏色 / Color
(5) RGB 顏色 / RGB Color
(6) CMYK 顏色 / CMYK Color
(7) 色盤 / Color wheel
(8) 光束強度 / God Ray
(9) 效果片
(10) 其他屬性 / Features (lris / Shutter)
(11) 柔邊係數
(12) 用途備註 / Purpose
(13) 圖層 /Layer
(14) 更換吊桿
(15) Spin / Till / Pan
(16) 焦點 Focus
(17) 燈光預覽 / Preview
(18) 流明值 / Lumen
(19) 色票文字偏移
(20) Chan 文字偏移



57

(1) Channel :
This function facilitates management of lights by collecting multiple lights in a channel and showing the 

entered value in the light plan UI in Top View. In the cue list, only lights in channels can be cued.

(2) Dimmer :
You may set light dimming levels in a numeral form here, and by clicking on "?" you can see an overview of 

all dimmers in the Main Theatre.

(3) Color Temperature :
Changing color temperature values will lead to change in lighting colors. The acceptable range of the 

values is 2700~6500. A smaller value causes a warmer color and a greater value causes a colder color.
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(4) Color :
This means the color of a filter used for a light. This application has been preloaded with the filters 

prepared by the Center and their standard serial nos. To set a filter, you can either select it from a drop-

down menu or enter the serial No. of the filter directly.

(5) RGB Color :
The color of the filter can be sent using RGB values. To save the RGB color, please click on the block of 

Custom Colors at the lower left corner, click on the color to be saved, and press Add to Custom Colors.

(6) CMYK Color :
The color of the filter can be sent using CMYK values.
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(7) Color Wheel :

(8) God Ray :
Enter a value between 0~100. The greater the value is, the more intense the light beam is.

(9) Gobo Dynamic :
This is the slideshow of the lamp, select image in the Gobo column, you can see the slideshow and the 

standard number that the center has purchased, for users to make quick settings, which will directly reflect 

the display effect during lighting demonstration .
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(10) Features (lris / Shutter) :
After pressing Features, you can see a window for you to adjust values of Iris and Shutter. Iris is to set the 

diaphragm of lights, and Shutter is to set light shutting.

Setting Iris under Lighting. This setting affects the range of the light beam projected. The value should be 

between 0~100. The greater the value is, the softer the edge is.

Shutter under Lighting is to cut the light beam using the shutters at four sides so as to make the light 

change in geometry. The black parts are where light is shut.
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(11) Softness Coefficient :
The greater the entered value is, the softer the edge is.

(12) Purpose :
For a note. After input in the field, it will be displayed it's UI on Top View.

(13) Layer :
This function is to be used in conjunction with "Layer" in the data management area. By checking 

View or Lock, you can make the affected layer displayed or locked so as to facilitate classification and 

management of the lighting in the scene.

(14) Flyer :
This function shows to which batten the light is attached. A drop-down list provides all battens/lighting 

towers' serial nos. in the scene, and you can hang a light on a selected batten. This arrangement can be 

adjusted and changed later.



62

(15) Spin/Till/Pan :
This function is used to move the lights and set the lights' beaming angles by entering angle values.

The results of different Spin values (from the right to the left being 0/20/40)

The results of different Tilt values (from the right to the left being 0/30/60)

The results of different Pan values (from the right to the left being 0/20/40)

(16) Focus :
There are two ways to set Focus points.

1 You may set Focus points under "Focus" in the data management area on the left first, and then return 

to Attributes to import the preset Focus points using the drop-down menu. The detailed steps are given 

below

→ 
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Step 1. Under Lighting, click on + in Focus

Step 2. Add a Focus point, such as "Focus_1" in the image below, and click on ⊙ ，of "Focus_1." When 

the mark turns red (as shown in the image below), you can click on the point to put the focus in the scene.

Step 3. After setting the Focus point, please press ⊙ again to make it turn back greyfrom, thereby 

finishing the setting.

Step 4. After setting, the Focus point can be directly selected from the drop-down menu in Attributes 

under Focus.

2 In addition to the foregoing method, you may click on ⊙ ，in Focus under Attributes directly, and 

then, click on the point to be focused on in the scene when the mark is red. The setting is thus finished.
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(17) Preview (%) :
This function provides preview of the lights' intensity. You can enter a value between 0 and 100, with 0 

representing full darkness and 100 representing full lightness.

(18) Lumen :
The value should be between 3000~1000000.

(19) UI Color Text Offset (%) :
You can type tne value here.

(20) UI Channel Text Offset (%) :
You can type tne value here.
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5. Cue

This section will explain how to set cues of lighting in detail

Step.1 Set Channel:
In Top View, hold Ctrl while selecting multiple lights whose attributes have been set to collect them in the 

same channel. Once set, a channel will have its number seen in the cue list under Lighting.。

Step.2 Set Mode for Lighting Cue：
Click on System Setting and check either "Cue Only" or "Tracking" in the window Editor as the mode for 

lighting cues. Please make this setting with care and avoid changing the mode later.

Step.3 Set Cue

Set up the time of Up/Down/Focus/Color/Beam individually. Double click the blue area to access Cue Cell 

Editor, in which you can enter a value of Intensity.Additionally, if a computer light is used, you can edit its 

change in this cue using the same Editor.
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(1) General-Light-Specific Cue Cell Editor：
A general light only support limited settings. You may edit its in/out and intensity in a cue.

(2) Computer-Light-Specific Cue Cell Editor：
A computer light allows much more changes. In addition to the basic settings such as intensity and in/

out, you can make adjustments in Color, Gobo, Features, Ficker, Iris, Soft, Rotation and Fov. The items 

other than Gobo and Ficker have been discussed in previous sections, so the following description will be 

directed to Gobo and Ficker.

* click "?" under the "Attributes" you can see the detail of the light.

Step.4 Set Start Time

With the mode decided, you can start to set cues. Right click the mouse to add a new row of cues. You 

can designate when to start the lighting cue using Start Time.

  

→ 
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Step.5 Set In/Out Time

Following the cue process of the lighting, each lighting cue is played with the previous lighting cue.

Step.6 Set Trigger

Double click below Trigger and you will see Cue Triggering Editor for you to select from Link and Follow, 

and the corresponding cue number.

• Link: Directly jumping to a later cue (e.g. if Cue1 is set as Link to Cue3, when Cue1 is finished, the 

process will jump to Cue3 directly).

• Follow: Directly proceeding with the next cue (e.g. if Cue1 is set as Follow, when Cue1 is finished, the 

process will proceed with Cue2).

  

→ 
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Step.7 Execute Cue

Move the mouse to the left and select a cue field. Switch the scene to "Free View." Click on Stop under 

Playback, and zero all the attributes. Then click on GO to preview the lighting effects of this cue.
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(III) Audio
This system has been preloaded with the audio equipment the "Taiwan Traditional Theatre Center" has 

acquired for you to use in the audio system. The operations involved are "Icon Audio," "Audio Library," 

"Import Audio File," "Icon Audio File List," " Audio Library", "Attributes" and "Audio Cue List." This system 

provides no sound field effects.

1. Audio Library

Step 1. Click on Icon "Audio" icon

Step 2.The contents of Library now become the entries of the audio module

2. Audio File List

Step 1. Click on Icon "Audio File List" icon

Step 2.The contents of Library now become the entries of the audio module, and you can import audio 

files here
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3.Set Attributes

You can set positioning points for audio equipment to go on/off the stage.

4 .Cue

Step 1.  Import Audio

Select "File>Import>Audio File" in the main menu to import the audio file you need.

*Note: The file has to be in the format of wav. or mp3., and should be named in English.
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Step 2.  Audio Cue List:

After imported, the file can be seen in the cue list below.

You can leave the field Stand-By remaining its default values. After the time length of every cue is set, 

please double click the mouse to access Cue Cell Editor, in which you can set Audio Volume, Time Start & 

Duration Time, and In/Out Time. For example, if you want the audio to fad in over 5 seconds, please enter 

"5" in the table. After all the foregoing settings, please move to the left and select the field Cue. Then click 

on Stop above to zero all the attributes, and click on Playback to preview the audio effects of this Cue.
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(IV) Projection
This system has been preloaded with the video equipment as "Taiwan Traditional Theatre Center" plan to 

have for you to arrange projectors in the video system. The operations involved are " Icon Video ", "Video 

Library," "Import Video," "Icon Video Lost," "Video Library," "Attributes" and "Audio Cue List."

1. Projector Library

Step 1. Click on the icon of Video.

Step 2.Entries related to video settings will be shown in the field of Library.

2. Video List

Step 1. Click on the icon of Audio File List.

Step 2.Entries related to video settings will be shown in the field of Library. To import video files, 

press"+"at the lower left corner.

3. Import Video

File > Import  > VideoFile.

*Note: The file has to be in the format of .avi, .mov, .m4v or mp4., and should be named in

English.
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4. Set Attributes

                                     Settings about the projector can be made here.

5. Cue
This sector will be focused on how to import video files and how to edit cue lists.

Step 1. Import Video

Select "File >Import >Video File " in the main menu to import the videos you need in the

format of avi, mov, mp4, or mpeg.

Step 2. Video Cue List 

After projectors are set, you can see the 

projectors' model names in the cue list below.

You can leave the field Stand-By remaining its 

default values.

Double click on Cue1 to access Cue Cell Editor.

→ 
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You can set the video to play, the time to play the clip (Time Start), Duration Time, and In/Out Time. 

For example, if you want the video to be fade in over five seconds from darkness, please enter "5" in the 

blank space.

Set Start Time and Duration Time of the cue.

After all the foregoing settings, please move to the left and select the field Cue. Then click on Stop above 

to zero all the attributes, and click on Playback to preview the video of this Cue.



(V) Effects
This system has been preloaded with the video equipment the "Taiwan Traditional Theatre Center " plans 

to have for you to arrange smoke machines, fog machines and snow machines and set their effects in the 

effect module. The operations involved are "Icon Effects," "Effect Library," "Attributes" and "Effect Cue 

List."

1. Effect Machine Library

Step 1. Click on Icon Effects.
Step 2. Entries related to effect settings will be shown in the field of Library.

2. Set Attributes

You can make fine-tuning on position and rotation of effect equipment and set layers here.

3. Cue

This section will be focused on how to edit cue list of effects.

Step 1. Import Effect Machine from Library

Drag effect machine form the library to the scene, and then you can set cues there to using the relevant 

field in the cue list .
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→ 



76

Step 2. Add Motion for Effect Machine

Click on effect machine, and click on +in the part Motion under Attribute on the right to add a motion for 

the effect machine.

Step.3 Edit Cue List

Click on a cue below to access Cue Cell Editor of this cue, in which you can set motions, duration times, 

start times and interval times of the effect machine in this cue.
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(VI) Character
This system has been preloaded with characters often used in the "Taiwan Traditional Theatre Center," 

including "male roles, female roles, painted faces, clowns," for you to set blocking in the character module. 

You can use this together with motorized devices (such as the turn-table, the trap room platform and 

the rigging system) of the stage system to edit blocking of characters. The operations involved are "Icon 

Character," "Character Library," "Attributes" and "Character Cue List."

1. Character Library

Step 1. Click on Icon "Character"

Step 2.Entries related to character settings will be shown in the field of Library.

2. Set Attributes

You can edit Layer and Motion of the selected characters.

3. Configure and Edit Character

(1) Configuration on Stage

This section will introduce how to configure characters on the stage and set their attributes.

• Configure Character：

DSPA provides some preloaded characters, and you can drag them from Library to the stage. To import a 

new character, just press + at the lower left corner of the library.

→ 
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• Set Attribute of Character：

Click on a character, and then you can in the window Attributes to set layers and motions of this 

character.

• Set Motion of Character:

Click on a character, and move it to the positioning point. Then you can click on + under Motion in the 

window Attributes to add a new positioning point and enter Motion Name, Position and Degree Z in Motion 

Editor. The basic setting (Transform) can be also used when making character settings.

(2) Configure Character using Stage Gear

This section is about how to edit stage gears for characters. You may have a character make motions on 

his/her own, or you can assign stage gears to drive a character's motion. The process is a below:

Step 1. Configure Character

"Free View" is recommended for setting a character's interaction with the turn-table or the trap room. You 

can drag a preloaded character to a stage gear, such as the turn-table or the trap room in the stage in 

the main window, and place the character on a proper position on the gear.

→ 
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Step.2 Set Character Attribute

Click on a character to set its Layer and Motion in the window Attributes. However, if the character is to 

be driven by a stage gear, please do not set a motion for it, or the character's motion will prevail.

Step.3 Set Gear Attribute

Click on a stage gear to making its settings in the window Attributes. A gear may have plural attributes to 

set. Attributes of the trap room and turn-table attribute will be described below for illustration. (Degree Z)

may be used with Transform for setting.

• Trap Room：

The attributes editable are Layer, Center Stage Type and Motion. To set multiple motions, please click on 

+ of Motion to access Motion Editor, in which you can set the altitude (the Z axis) of each trap platform 

to lift the relevant character on the stage.

• Turn-Table：

The attributes editable are Inner Ring Motions, Inner Ring Motions and Outer Ring Motions in either 

direction. Click on + of Motion to access Motion Editor, in which you can the position (Degree Z) of each 

ring of the platform to drive the characters or properties on the stage to move therewith.



80

4. Cue

(1) Set Cue List

After the characters are configured, the file name will appear in the cue list below.

You can leave the field Stand-By remaining its default values.

Double clicking on the field Cue1 can open Cue Cell Editor.

Use the drop-down menu to select a preset motion and set its duration time.

Set Start Time and Cue Time of this cue.

After finishing the foregoing settings, move to the left to select the field Cue and click on the button Stop 

above to zero all the attributes. Then click on Playback to preview the effects of this cue.
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Director Mode6



82

(I) Director Mode Function

The view of Director mode includes "Main Window " and "Director's Cue List. "Main Window" is where 

scenes are previewed and "Director's Cue List" is where cues of different departments are overviewed. 

You can use "Q-group" in the data management area for advanced management.

(II) Access Director Mode

Select "Director" under "Mode" in the main menu, and click on "Director" it the cue list below to access the 

cue list of Director Mode.

(III) Interface

1. Window

The view of Director mode includes "Main Window " and "Director's Cue List. "Main Window" is where 

scenes on the stage are previewed in a real-time manner and "Director's Cue List" is for you to manage 

various cue lists.

2. Cue List

The cue lists of the foregoing seven modes are collected here, including stage rigging (SFQ), stage 

property (SSQ), lighting (LQ), audio (AQ), video (VQ), effect (EQ) and character (CQ).

Main Window

Director's Cue List
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3. Playback Area

When operating the system in Director Mode, you can use these buttons to control

the playback of cues.

PREVIOUS CUE/ GO / PAUSE / STOP/ NEXT CUE

4. Time Scale 

The range to preview is defined by the start time and the end time you entered. Total on the right shows 

the total length of this director's cue list.

5. Time Scale Marker

You can use mouse to drag and move the time scale marker and the objects in the scene will move 

accordingly in a real-time manner for your preview. The markers can be moved only when the cue list is 

not being played.

(IV) Mode Preview

This section will further explain how to have a preview in Director Mode.

1. Timeline

A timeline has three time points, namely Start, Current, and End, which are expressed in "Hr., Min., Sec., 

Frame.” You may define a part you want to check by entering the start time and the end time.



84

2. Time Marker

Under Director Mode, you can drag the marker along the timeline to preview the real-time scenes of the 

whole performance.

3. Change Viewpoint

During playback
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(V) Manage and Operate Director's General Cue List

The director can adjust cue parts through the interface of the cue list directly and change the start time 

by moving the cues along the timeline. However, adjustments to detailedfunctions have to be made in their 

respective departments. Q-Group can be used to make time control for segments.

1. Drag Cue

To change the start time of a cue, please use the mouse to drag it directly.

Alternatively, you can check the block "Related" at the lower left corner to move the

cues in the entire mode.

2. Q-Group

Under Director Mode, you can use this function to group cues in time segments for easy 

management. It is possible to change groups' colors and change the start time of every group.

• Set Block

Click on Arrange Range to access Cue-Group Editor in which you can enter the start time 

and the end time of this play. The settings will be directly reflected in the cue list.
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• Change Color

• Lock Area

You may lock the whole segment by checking Lock. The locked segment cannot be altered or moved.

• Change Overall Start Time

You can see the start time of the segment you are working on under Start Time, and changing the 

start time will change the start time of the whole segment.
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VR Mode7
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(I) Installation

See "Steam Installation" in p.13

(II) Use In System

1. View Scene

Step 1.After putting on the headset, you can view the arrangements of the scene.

Step 2.You can walk around in the area defined by the virtual fence you set during initial VR setup and 

approach objects.

2. Operation

Step 1. If the VR system was initially set in the standing mode, the user's motions in the scene have to 

be made using the controller. Please hold the button on the trigger, move the light beam to a position you 

want to move to, and you will be moved to the position when releasing the trigger button.

Step 2. If the VR system was initially set in room mode, the user is allowed to walk around within a 

predefined range but the controller is necessary for the user to move to a further position. To do this, 

please hold the button on the trigger, move the light beam to a position you want to move to, and you will 

be moved to the position when releasing the trigger button.

(III) Export

1. Export 360VR Videos

(see P. 38 above)
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2. Upload Video

Step.1 Please put the video into the downloaded application for format conversion.

Step.2 Please upload the converted video to YouTube.

Step.3 After YouTube processes the file, you can use the mouse to drag the scene to see the 360 

scene, or use VR glasses or a cardboard to watch it.

(The above description is based on practice as of 2019. Shall the process is modified by the service 

provider later, please follow the instruction given by YouTube then.)

3.Recommended Device For Watching Video
For users' information, the image below shows a cardboard device commonly used for this purpose.



External Model8

For detailed settings of external models, please check the external model 
conversion manual.
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This application is based on a 3D structure and is preloaded with commonly 
used stage scene models and stage library models for convenient deployment. 
However, some plays may require stage scenes and properties not included 
here. Hence, this application provides a chance for users to import models 

separately produced using 3D CAD-based applications and to export internal 
models. Most 3D CAD-based applications can export their contents as *.FBX 
files, so we have selected this format as the importable format of this system. 
This system reads only files in *.FBX format. 
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